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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
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Postfach 48 48
90026 NÜRNBERG
GERMANY

A5E51908378-AD
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Validity 1
Validity

This update is valid for the following products:
• STEP 7 Basic V17
• STEP 7 Professional V17
• WinCC Basic V17
• WinCC Comfort V17
• WinCC Advanced V17
• WinCC Professional V17
• WinCC Unified V17
• TIA Portal Openness V17

Note
If you modify your system after installing the update with the product DVD, you will have to 
perform the update again.
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Improvements in STEP 7 2
2.1 Improvements in Update 4

This update contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved, partly based on the feedback 
from returned crash reports.

Animated maximizing or minimizing of windows on high-resolution monitors
Animated maximizing or minimizing of windows in the project view results in display problems 
on high-resolution monitors. This behavior occurs with animated maximizing or minimizing of 
the task cards, the project tree and the Inspector window.
To bypass the display problems, disable animated maximizing and minimizing. To do so, select 
the "Settings" command in the "Options" menu. Open the "General" entry in the area navigation 
of the settings. In the "General Settings" group, uncheck the check box "Window animation: 
Animate window during maximizing and minimizing". 

Monitoring a program (S7-1200/1500)
Monitoring a program can significantly increase the cycle time of the CPU, depending in each 
case on the number of variables to be monitored and the number of loops used. 
When monitoring is switched on, a dialog box warns of the possible increase in the cycle time. 
In this dialog box, you can continue or abort the monitoring. 
To prevent this dialog box from being displayed again, while the project is open, check the check 
box "Do not show again" and end the dialog with "Yes". 
If the dialog is ended with "No", the check box has no effect.

Readme
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2.2 Improvements in Update 3
Update 3 contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved.

Behavior of the protection levels of S7-300 and S7-400 CPUs
The preset behavior of the protection levels of S7-300 and S7-400 CPUs has been improved.

Password complexity check
The complexity check of passwords for the protection levels of S7 CPUs has been improved. 

Improvements in STEP 7
2.2 Improvements in Update 3
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2.3 Improvements in Update 2
Update 2 contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved, partly based on the feedback 
from returned crash reports.

Security note on know-how-protected blocks and projects
When protecting blocks and projects, note that full password protection is not provided until you 
log the project. 
Optimization of project data during logging removes older, potentially unprotected project 
content.

Improvements in STEP 7
2.3 Improvements in Update 2

Readme
Readme, 06/2022, A5E51908378-AD 9



2.4 Improvements in Update 1
Update 1 contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved, partly based on the feedback 
from returned crash reports.

Software units
The behavior of the block interface inside and outside of software units has been standardized: 
If you change or delete PLC data types that are used in the block interface, the interface becomes 
inconsistent. This is now also the case if you delete relations on PLC data types or if you change 
the property "published" of a PLC data type. To remedy this inconsistency, the interface has to be 
updated.

S7-1200 CPU is not accessible in "Commissioning mode"
Asynchronous commissioning is only possible to a limited extent with CPUs from the S7-1200 
family, since the S7-1200 CPUs cannot maintain online connections to several instances of the 
TIA Portal at the same time. As soon as you establish an active online connection to your CPU 
while working in asynchronous commissioning, an attempt is made to open a second TIA Portal 
instance, which is not possible for the S7-1200 CPUs.  
The process is then canceled with an error message. 
This results in the following rule: 
You can work with asynchronous commissioning provided you are not connected online to your 
S7-1200 CPU in the TIA Portal. In this case, only one instance of the asynchronous 
commissioning is connected online with the S7-1200 CPU in the TIA Portal.

Improvements in STEP 7
2.4 Improvements in Update 1
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Improvements in WinCC 3
3.1 Important notes

This page contains important information about product properties

Character sets after Windows 10 update
Since Windows 10 Update Version 1809, Windows allows the installation of character sets either 
with administrator rights for each user (command "Install for all users" in the shortcut menu) or 
for specific users. In order to use WinCC character sets without restrictions and load them onto 
an HMI device, the character sets must always be installed with administrator rights.
Note that the "Install" button in the view of a character set only initiates a user-specific 
installation.

Changing the installation directory
If you had installed the simulation with an earlier version of WinCC, you can no longer change 
the installation directory during installation.

Access to array variables via OPC UA
If you use WinCC Runtime Advanced as OPC UA server, reading array tags is only supported when 
the "OPC UA Server Array index range access" setting is activated.
Writing array variables is only possible if the OPC UA client supports the "Write array elements 
without IndexRange" setting.

PLC code view
The performance of the PLC code view when opening the S7-GRAPH overview depends, among 
other things, on the number of jumps to be displayed.

Readme
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3.2 Improvements in Update 4
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Comfort PRO devices: "CalibrateTouchScreen" system function
As the calibration of the touch screen of Comfort PRO Panels is not possible, the system function 
"CalibrateTouchscreen" can no longer be configured for these devices in the engineering system. 

Runtime Professional: Setting the background color via VB script
The background color property can also be set correctly for the following objects using VB script: 
Line, polyline, circular arc, ellipse arc, connector 

Improvements in WinCC
3.2 Improvements in Update 4
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3.3 Improvements in Update 3

Contents
This update does not contain any improvements or changes relevant to WinCC.

Improvements in WinCC
3.3 Improvements in Update 3
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3.4 Improvements in Update 2
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Improvements in WinCC
3.4 Improvements in Update 2
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3.5 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Improvements in WinCC
3.5 Improvements in Update 1
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3.6 Runtime Advanced

3.6.1 Improvements in Update 4

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

3.6.2 Improvements in Update 3

Contents
This update does not contain any improvements or changes relevant to WinCC Runtime 
Advanced.

3.6.3 Improvements in Update 2
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

3.6.4 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Improvements in WinCC
3.6 Runtime Advanced
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3.7 Runtime Professional

3.7.1 Improvements in Update 4 
This update contains the following improvements and changes:

Setting the background color via VB script
The background color property can also be set correctly for the following objects using VB script: 
Line, polyline, circular arc, ellipse arc, connector 

3.7.2 Improvements in Update 3 SR1

3.7.2.1 Improvements in Update 3 SR1
This update contains the following improvements and changes:

Stability and performance
Improvements including stability and performance have been made based on the feedback 
received.

Screen keyboard
With the screen keyboard, the response time when opening and the behavior when exiting 
Runtime have been improved.

Symbolic I/O field
When changing the visibility of object groups, for example, the behavior of the symbolic I/O 
fields used has been improved.

Screen window in multi-monitor mode
The display of independent screen windows in multi-monitor mode has been improved.

Startup behavior of Runtime
The startup behavior of Runtime has been improved when there is no network connection.

ALARM_DQ alarms
Alarm_DQ alarms are displayed correctly in the alarm control. 

Improvements in WinCC
3.7 Runtime Professional
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Allen-Bradley
If non-configured tags are used, communication via the Allen-Bradley channel is improved.

WebNavigator
WebNavigator Clients V17 can also connect to WebNavigator servers with different versions.

3.7.2.2 Secure communication via certificate
Runtime Professional certificate-based communication has been enhanced.

Overview
Supported S7 PLCs
Runtime Professional V17 can now communicate with the following S7 PLCs via certificates:
• S7-1500 PLCs as of firmware 2.9 
• S7-1200 PLCs as of firmware 4.5 

Note
All of the following statements apply only to S7 PLCs with this firmware.

Expansions
Certificate-based communication between Runtime Professional and S7 PLCs has been 
enhanced as follows:
• Communication between HMI devices and S7 PLCs with a non-integrated connection now 

supports self-signed certificates.
• Upgrading S7 PLCs has been simplified. Upgrading in the TIA Portal is no longer mandatory.

An S7 PLCs that was only upgraded in the field now communicates with the HMI device via 
a self-signed certificate. The self-signed certificate is automatically loaded from the PLC into 
the certificate store of the HMI device. 

To use these functions, enable the "ForceSecure" option on the HMI device.

Improvements in WinCC
3.7 Runtime Professional
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Using self-signed certificates
The following self-signed certificate options are available:
• Use a self-signed certificate generated in the TIA Portal.

Use the certificate created automatically when adding an S7 PLC or upgrading an existing S7 
PLC. Or select certificate settings that differ from the default settings and generate a self-
signed certificate yourself.
When loaded, the certificate is copied to the Runtime project folder. 

• Use a self-signed default certificate.
Do not provide a certificate for the PLC in the TIA Portal and instead enable the "ForceSecure" 
option on the HMI device for the PLC connection type.
A self-signed certificate is generated when loading to the PLC. The certificate is copied to the 
certificate store of the HMI device during the first attempt to make a connection between the 
PLC and the HMI device. After the certificate is copied to the folder with trusted certificates, 
it is used for communication. 

Enabling or disabling the "ForceSecure" option
Introduction
The "ForceSecure" option ensures that communication between the HMI device and the S7 PLC 
is protected by a certificate for the following connections:
- Non-integrated connections 
- Connections for which no certificate has been configured in the TIA Portal 
If the option is enabled and no PLC certificate is found in the Runtime project folder, Runtime 
searches for a suitable certificate in the "trusted" folder of the HMI device's certificate store.

Note
This option does not affect communication with S7 PLCs that do not support certificates.

Default setting
This option is disabled by default for integrated connections, non-integrated connections and 
device proxies. 

Procedure

Note
It is recommended to enable the option for all connection types.

Improvements in WinCC
3.7 Runtime Professional
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To configure the option for an HMI device, proceed as follows:
1. Create the "ForceSecure.xml" file.
2. Copy the following XML structure into the file:

<?xml version="1.0"?> 
   <root> 
   <NonIntegrated>true</NonIntegrated> 
   <Integrated>true</Integrated> 
   <IntegratedProxy>true</IntegratedProxy> 
   </root>

3. To disable certificate store evaluation for one of the connection types, set its node to "false".
Note
Certificate-protected communication for non-integrated connections is not possible in this 
case. 
For integrated connections and device proxy, certificate-protected communication is 
possible only after upgrading the PLCs in the TIA Portal.

4. Copy the file on the engineering device into the TIA project directory of the project to which 
the HMI device was added into the following folder: 
"…\AdditionalFiles\Rdp"

5. Compile and download the HMI device.
Your settings will be applied to the communication between the HMI device and its 
connected S7 PLCs.

To configure the "ForceSecure" option centrally for all projects created in the TIA Portal, proceed 
as follows:
1. Perform steps 1 to 3 as described above.
2. Copy the file on the engineering device into the program directory "C:\ProgramData\Siemens

\Automation\ConfigFiles\RDP".
3. To use a different configuration for individual projects, proceed as described in steps 1 to 4 

above. 
If the XML file is located in the program directory and in the TIA project directory, the 
configuration from the project directory takes effect.

Upgrading S7 PLCs
The following options are available when using self-signed certificates.

Upgrading in the field without upgrading the S7 PLC in the TIA Portal
Requirement: 
On the HMI device connected to an S7 PLC, the "ForceSecure" option is enabled for the S7 PLC 
connection type.
Procedure:
1. Upgrade the HMI device in the TIA Portal.
2. Replace the S7 PLC and the HMI device in the field.

Improvements in WinCC
3.7 Runtime Professional
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3. Download the S7 PLC and the HMI device.
After the download, the Runtime project folder does not contain a certificate for this S7 PLC. 

4. Start Runtime.
At the first attempt to make a connection, the self-signed certificate is automatically loaded 
from the S7 PLC. It ends up in the certificate store of the HMI device in the following folder:
%PROGRAMDATA%\Siemens\Automation\device-certificate-store
\untrusted 

5. Copy the PLC certificate in the certificate store of the HMI device to the folder with the trusted 
certificates manually or per script:
%PROGRAMDATA%\Siemens\Automation\device-certificate-store\trusted
\certs 

Upgrading in the field and upgrading in the TIA Portal
Procedure for integrated connections and device proxy: 
1. Upgrade the S7 PLC and HMI device in the TIA Portal.
2. Replace the S7 PLC and the HMI device in the field.
3. Download the S7 PLC and the HMI device.

After the download, the Runtime project folder contains the certificate for this S7 PLC. 
4. Start Runtime.

HMI device and PLC trust each other's certificates. There are no further steps for you.
Procedure for non-integrated connections:
1. Upgrade the S7 PLC and HMI device in the TIA Portal.
2. Enable the option "ForceSecure" for the non-integrated connection type for the HMI device.
3. Replace the PLC and the HMI device in the field.
4. Download the PLC and the HMI device.

After the download, the Runtime project folder does not contain a certificate for this S7 PLC. 
5. Start Runtime. 

At the first attempt to make a connection, the self-signed certificate is automatically loaded 
from the S7 PLC. It ends up in the certificate store of the HMI device in the following folder:
%PROGRAMDATA%\Siemens\Automation\device-certificate-store
\untrusted

6. Copy the PLC certificate in the certificate store of the HMI device to the folder with the trusted 
certificates manually or per script:
%PROGRAMDATA%\Siemens\Automation\device-certificate-store\trusted
\certs
HMI device and PLC trust each other's certificates.

Alternatively, you can export the PLC certificate from the TIA Portal in advance and copy it to the 
"...\trusted\certs" folder before starting Runtime. The certificate file must have the 
following name: 
"S7PlusChannel_<PLC_IP>.der", e.g. "S7PlusChannel_192.168.0.1.der"

Improvements in WinCC
3.7 Runtime Professional
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3.7.3 Improvements in Update 2
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

3.7.4 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Improvements in WinCC
3.7 Runtime Professional
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3.8 Panels

3.8.1 Improvements for Panel
This update contains the following improvements and changes:

New device versions
• Images for new devices versions are authorized depending on the TIA Portal Updates. 
• If you are using a device with a new device version in the project, install the new images 

before loading the device. When loading this device, activate the setting "Keep aspect ratio" 
in the "Load preview" dialog so that the image version is transferred to the Panel.

• Use ProSave if you want to copy a new image version to a Panel without loading the device 
afresh. 

• Images can be downloaded from the Industry Online Support (https://
support.industry.siemens.com/cs/ww/en/view/109746530).

3.8.2 Improvements in Update 2 (Panels)
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

RSA key exchange
In line with recommendations on the use of Transport Layer Security (TLS), as of firmware 
version 17.0.0.2, RSA key exchange is rejected by default because it does not provide Perfect 
Forward Secrecy.
If the communication partner requires an RSA key exchange, you can allow this procedure by 
deactivating the "Deny RSA key exchange" option in the Internet settings of the integrated web 
server.
If you want to find out which security-relevant protocols a device supports, you can use tools to 
test the SSL/TSL connection.

3.8.3 Improvements in Update 1 (Panels)
This update contains the following improvements and changes:

Improvements in WinCC
3.8 Panels
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Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Improvements in WinCC
3.8 Panels
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Improvements in WinCC Unified 4
4.1 Important notes

This page contains important information about product properties

Device versions with V17 Update 1
The new device version 17.0.0.1 was introduced for Unified PC and Unified Comfort Panels in 
order to be able to use the new functions which have been introduced with V17 Update 1. Please 
note the following:
• If you open a project on a computer on which TIA Portal V17 is installed without an update, 

you cannot edit the devices contained there with device version 17.0.0.1.
• If you switch from a device version 17.0.0.1 to a previous device version, you can no longer 

use new functions such as switching the visibility of layers or the "Authorization" interface 
property for faceplates.

• The functions are also supported by higher device versions.
Unified PC
• Install Update 1 for WinCC Unified Runtime on the target device before loading a device with 

device version 17.0.0.1.

Images for Unified Comfort Panel
• Images can be downloaded from the Industry Online Support.
• Images are released independent of WinCC (TIA Portal). 
• Use ProSave to import an image version that does not correspond to the configured device 

version onto a panel.
• If a new image only contains improvements for the runtime of the device, this version is not 

shown in the engineering system. In this case, use the most recent device version displayed 
in the engineering system.

• If the image 17.0.0.0 is installed on the device, install image download version V17.0 Upd.1 
or higher before you load a device with the configured device version 17.0.0.1. When loading 
this device, activate the setting "Keep aspect ratio" in the "Load preview" dialog so that the 
new image version is transferred to the Panel. Alternatively, use ProSave.

• If you load a device with the configured device version 17.0.0.0, it is not absolutely necessary 
to update the image on the panel. If you load a device with the configured device version 
17.0.0.0 onto a Panel with a higher image version, warnings are issued regarding the 
different versions. You can ignore them.
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Character sets after Windows 10 update
Since Windows 10 Update Version 1809, Windows allows the installation of character sets either 
with administrator rights for each user (command "Install for all users" in the shortcut menu) or 
for specific users. In order to use WinCC character sets without restrictions and load them onto 
an HMI device, the character sets must always be installed with administrator rights.
Note that the "Install" button in the view of a character set only initiates a user-specific 
installation.

"Allow operator control" property for operable screen objects
If you disable the option of operation in runtime for objects of the "Elements" group using the 
"Allow operator control" property, the object is grayed out in the engineering system and in 
runtime. For objects of the "Controls" group, the "Allow operator control" property affects 
operable areas, e.g. toolbar buttons.
The objects are displayed in engineering system as well as in runtime. 

Number of connections used in the connection overview
An S7-1200 PLC can be connected to up to 6 HMI Unified devices via integrated connections. 
Under certain circumstances, the number of connections used is not correctly displayed in the 
connection information of the device view for HMI communication. The connections can still be 
used without restrictions.

Key length of certificates for audit
Audit does not support certificates with a key length greater than 2048.

Supported trend modes
The trend control does not support the "Bar" trend mode. If you select the "Bar" trend mode in 
engineering, the "Values" trend mode is used in runtime.

Reports on Unified Comfort Panels
A memory card must be inserted to use reports on a Unified Comfort Panel.

Runtime language
When using central user management, runtime is displayed in the language you have selected 
in the "User login" during login.
If this language is not available for the current project or if the language setting was not set in 
the central user management, the language that was given the lowest number in the runtime 
settings during engineering is displayed.
If you do not select a language in the "User login" dialog, runtime is displayed in the language 
that is set for the browser.

Improvements in WinCC Unified
4.1 Important notes
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4.2 Improvements in Update 4
No new device versions are made available in the Engineering System with this update. This 
update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Alphabetical sorting for graphic types
The graphic types are sorted in alphabetical order in WinCC Unified in the project library and in 
the selection dialog for graphic types under "Properties > General > Graphic" in the "Static value" 
column.

"Screens" editor
If the "Same Width and Height" function is applied to the "Line" object, all relevant properties are 
transferred correctly.

Link to the referenced object
The resource list can be opened for editing via a link at the dynamization point.

Overlapping ranges in the dynamization of tags
Dynamization of an object property with tags of "Range" type can overlap the values in the 
individual ranges. 
Cells where range overlaps occur are highlighted in color. The overlaps are reported as a warning 
when compiling the project. Downloading to the device is possible. The first highlighted value 
is always used in runtime. 

Improvements in WinCC Unified
4.2 Improvements in Update 4
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"Find and replace" palette in the "Tasks" task card
The "Tasks" task card contains the "Find and replace" palette for searching within an open editor. 
The palette includes all options for an efficient search. The individual search hits or all found texts 
can be replaced.

Default sorting of alarm view
The order of column sorting has been improved.
• If the "Priority" column is defined in the alarm view, sorting is based on alarm priority. As a 

result, in a single-line alarm view, only the top-priority alarm appears in the alarm window. 
A lower-priority alarm will not be displayed, even if it is more recent. The alarms are displayed 
in chronological order.

• If one of the following columns in the alarm view is configured, sorting on a Unified Comfort 
Panel is according to the specified order.
1. Priority
2. Modification time
3. Raise time
4. Alarm state

Faceplates
To use graphics from the project library in faceplates, copy the graphic and paste it into the 
"Master copies" folder.
In a faceplate type, the entries in the Tags interface and the Properties interface can be selected 
individually or copied as an entire interface and pasted in the same place or in another faceplate 
type. To copy and paste, use the shortcut menu or the <Ctrl> + <C> and <Ctrl> + <V> key 
combinations.
To improve performance during the engineering process when using a large number of 
faceplates, activate the "Simplified display of faceplates on Unified devices" option under 
"Settings > Visualization > Unified Faceplate". The faceplates are displayed in a simplified way 
when this option is activated in the engineering system. This change has no effect on the display 
in runtime. In runtime, faceplates are displayed in unrestricted quality.
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Scripting
After a project is upgraded, the "Screen name" parameter appears in system functions. 
Global search in scripts: To find strings that are used in scripts, use the global search in the 
project. You access global search under "Edit > Search project" or by using the shortcut <Ctrl> + 
<F>. The search will also find system functions used in the project.
Even if an HMI device has been configured in a folder, the configured screens can be accessed via 
system functions, for example, when using the "ChangeScreen" system function.

Display of screen objects in the simulation
When using styles, frames are displayed identically in the simulation and on a Unified Panel.

Parallel communication with multiple PLCs via PROFINET interfaces
Parallel communication with several PLCs via the PROFINET interfaces X1 and X2 is possible.

View of Things
If a PLC is copied with a VoT application, the PLC can also be loaded after deleting the VoT 
application.
If the name of a member of a PLC user data type is changed and the interface in the PLC data type 
is updated, the referenced HMI tags are also updated.
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4.3 Improvements in Update 3

Contents
This update does not contain any improvements or changes relevant to WinCC Unified.
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4.4 Improvements in Update 2
No new device versions are made available in the Engineering System with this update. This 
update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Unified Collaboration
The "Parameter set control" and "Reports" screen objects can be used in screens that are 
displayed via Unified Collaboration in another runtime.
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4.5 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

WinCC Unified Runtime for SIMATIC Panel PC
The following SIMATIC Panel PCs support WinCC Unified Runtime:
• IPC227G
• IPC277D
• IPC277E
• IPC277G
• IPC477E
• IPC 677E
• ITP 1000
After creating the device, you can insert a "SIMATIC WinCC Unified PC" into the device in the 
"Devices & Networks" device view. The default size for screens is automatically adapted to the 
device.

Unified Collaboration
Unified Collaboration supports alarms. 

Note
For alarms of a remote HMI device to be displayed in the alarm control, the HMI device must 
participate in Unified Collaboration.

When using alarm controls in connection with Unified Collaboration, note the following:
• For an alarm view, the "System" property can be used to configure which HMI devices are 

taken into consideration in the alarm control.
• At least one HMI device must be selected.

Display of local alarms is the default.
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Visibility of layers in runtime
Unified Runtime supports switching the visibility of layers using JScript functions.
1. In the engineering system, place the objects of a screen in the "Layout" task card on different 

layers.
2. Program a JScript function to change the visibility of, for example, "Layer_1" in the current 

screen.
Screen.Layers ("Layer_0").Visible = false;

3. Configure this function, e.g. on an event of a button.
If the event occurs in runtime, all objects placed on this layer become invisible.
To make a layer visible in the current screen, use: Screen.Layers("Layer_0").Visible = true;

Improvements in the screen editor
• The display of the objects in the "Toolbox" task card can be switched between an symbol view 

and a list view. In the symbol view you can switch the labeling of the objects on or off in the 
shortcut menu.

• To improve the visibility of the "Touch area" object in the engineering system, it is shown as 
a dotted area. This change has no effect on the display in runtime.

• If you have selected several objects, they are highlighted with a frame, the color of which 
depends on the background color of the screen.

• If you change the size of an object with the mouse while pressing the <SHIFT> key, the size 
can only be changed according to the aspect ratio.

• If you move a selected object with <SHIFT> and arrow key, the increment is based on the 
settings configured for the grid under "Options > Settings > Visualization > Screens > Grid".

• If you have selected several objects and change a property, this change is applied to all 
selected objects that have this property.

• If you have selected several objects and dynamize a property, for example via a script, this 
dynamization is applied to all selected objects. 

• In the "Screens" editor, the background color of the work area that lies outside the visible 
screen has been changed in order to better delimit the area of the visible screen.

Multiple line text for screen objects
The line break is entered using the <SHIFT + ENTER> key combination.
For the following screen objects, the specification for the "General > Text" property can be 
entered as multiple line text in the Inspector window under "Properties > Properties":
• Text box
• Button
• Switch
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For the following objects, the specification can be made under "General > Title > Text". A multiple 
line text can never contain more than two lines.
• Bar
• Slider
For the following objects, the specification can be made under "General > Selection items > [x] 
Selection item > Text". A multiple line text can contain more than two lines if the "Format > Item 
height" property is adjusted accordingly.
• Check box
• Radio button
• List box
Multiple line texts with a maximum of two lines can be used in the text lists for symbolic IO 
fields. 
You can also enter multiline text in the Inspector window under "Properties > Texts" and for text 
box and button by entering text directly. The line break is entered using the <SHIFT + ENTER> key 
combination.

Dynamization of a property
Groups containing a dynamized property are shown in dark blue font.
Dynamized properties are shown in dark blue font and in bold in the Inspector window.
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Improved usability for configuring object properties
When screen objects are configured, advanced options are available for transferring the values 
of properties of an object collection. Examples of object collections are:
• The points of a polygon
• The points of a polyline
• The entries of a check box
• The entries of a radio button
• The columns of an alarm control
• The trend areas of a trend control
• The icons of a toolbar of a screen object
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To automatically fill in the values of properties for objects, follow these steps:
1. Select the collection according to the object:

– For polygons and polylines, click "Properties > Properties > Size and position > Points".
– For the elements, e.g. check box, click "Properties > Properties> General > Selection 

entries".
– With the controls, e.g. alarm control, click "Properties > Properties 

> Miscellaneous > Alarm control > Columns".
– For the controls with a toolbar, click "Properties > Miscellaneous> Status bar > Elements".

2. Select one or more contiguous cells in the collection in the right part of the Inspector window.
3. Drag the blue border around this cell up or down. The values are transferred to the 

destination cells.

Tips for effective procedure

With autofill, you can also create new points for polygons and polylines. If you select a cell in the "X coordinate" or "Y coordinate" 
columns and drag the blue border up or down, the value is transferred into the destination cells. If you select multiple cells and 
there is a logical relationship between the values, the values of the destination cells are adapted according to the logical 
relationship.

Improved usability when dynamizing properties with tags
When configuring the dynamization of tags, autofill can also be applied to the Condition column. 
If you select a cell and drag the blue border up or down, the value is transferred into the 
destination cells. If you select multiple cells and there is a logical relationship between the 
values, the values of the destination cells are adapted according to the logical relationship.

0 - 4 Extend by 3 cells down 0 - 4
5 - 9 5 - 9
 10 - 14
 15 - 19
 20 - 24
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Direct text entry in the text box and button
You can change the label of the text box and button objects directly via the keyboard when the 
object is selected and in input mode (double-click). Special consideration should be given to the 
following: 
• Diacritics, such as ä ê ñ, can only be entered if the keyboard layout provides a key for this 

character. Key sequences such as <`a> for à, are not recognized.
• It is not possible to enter Unicode characters using Alt codes.
• Asian language characters cannot be entered using an Input Method Editor (IME).
If you need such characters in the label, you have the following options:
• Use a keyboard layout on which this character is present as a key.
• Copy the character or full label from any source. Paste the text into the selected object.
• Edit the label in the Inspector window under "Properties > Properties > General > Text".
Direct text entry also supports multiline text. The line break is entered using the <SHIFT + 
ENTER> key combination.

Rewiring tags in screens
You can change the references of tags in the properties of screen objects using the "Change 
object references" dialog. This function lets you to replace a large number of tags in various 
screen objects. You open the "Change object references" dialog using the command in the 
shortcut menu for single or multiple screen objects or a screen.
1. Select an object in the screen that contains a tag that you want to change.
2. Select the "Change object references" command in the shortcut menu or in the "Edit" menu.

The "Change object references" dialog opens. You can see the selected screen objects and the 
tags used in the "Object" column. 

3. Enter the name or part of the name you want to find in the "Find in reference" text box.
4. Start the search with the "Find next" button. If a reference is found, it is highlighted in the 

"Reference" column.
5. Enter the name or part of the name you want to replace for the found name in the "Replace 

with" text box. 
6. Click the "Replace" button to replace the currently selected tag. The "Replace all" button 

replaces all references found.

PLC user data types with "Struct" PLC data type
HMI tags support the use of the "Struct" PLC data type in PLC user data types or in arrays of PLC 
user data types. This means that PLC system data types, such as IEC_*, ErrorStruct, CREF, NREF, 
are also supported.
The "Struct" PLC data type cannot be used in Unified faceplates. 
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Unified faceplates
The following improvements have been made:
• Unified faceplates support the interface property "Authorization". Assign function rights to 

the interface property . With these function rights you restrict the operator control of screen 
objects of a faceplate instance. 
If you specify the value "None" for the interface property on a faceplate instance, operator 
control is not restricted.
If an authorization has been configured in a faceplate type and no authorization is assigned 
to the associated faceplate instance, the relevant screen object is blocked for operator 
control. 

• OpenFaceplateInPopup: Only faceplate versions used in the HMI device are available in 
runtime. 
– Use the faceplate version in the HMI device in a container or in a script as a reference.

The reference is not resolved if you dynamically generate the name of the faceplate 
version to be opened as a popup with a script.

– If there is no faceplate version with the name, an empty container is opened.
• Delta download is possible in the case of changes to faceplate type tags of STRUCT data type 

when the associated PLC user data type has uncompiled changes.

Improved usability when programming scripts
In the script editor, the options for selecting faceplates, graphics, text lists, alarms and logs have 
been improved. You open the dialog for selecting objects with the <CTRL + J> key combination.

Swapping a graphic in runtime
You can swap the graphic shown in a graphic view with another project graphic using the 
following script.
export function Button_3_OnTapped(item, x, y, modifiers, trigger) {
Screem.Items("Grafik view_1").Graphic = 
HMIRuntime.Resources.Graphics("GraphicCollection.Engine5").Name
}
Where 
• Button_3: The object on which the script is configured.
• OnTapped: The event on which the script is configured.
• "Grafik view_1": The name of the graphic view in which the screen is swapped.
• Engine5: The name of the graphic to be displayed.

System function "GetSpecialFolder"
Returns the path of a folder. The system function is executed independently of the operating 
system (Windows or Linux).
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Example:
HMIRuntime.fileSystem.GetSpecialFolder(HMIRuntime.FileSystem.enums.F
olderId.Tempdir)); 
The system function "GetSpecialFolder" has the following parameters:

Parameters Type Description
FolderID Enum Placeholder that returns the requested folder:

• Temporary folder: HMIRuntime.FileSystem.Enums.Folder‐
Id.TempDir

• Home directory of the user: HMIRuntime.FileSys‐
tem.Enums.FolderId.HomeDir 

The following paths are typical:

Type Path in Windows Path in Linux
Temporary folder C:/WINDOWS/ServiceProfiles/WCCILScs‐

Service /AppData/Local/Temp/
/var/tmp/

Home directory of the user C:/WINDOWS/ServiceProfiles/WCCILScs‐
Service/

/home/industrial/

New method "GetClientInfo" on the UI object
With this method you can query the dimensions of the screen with which you access a running 
WinCC Runtime Unified. Based on this information, you can display a start screen suitable for the 
client.
Member
Method of the "UI" object
Syntax
HMIRuntime.UI.GetClientInfo(HmiClientInfoType);
Parameters

Parameters Type Description
HmiClientInfoType Enum Returns the dimensions of the screen:

• PrimaryDisplayWidth: Width of the screen in device-inde‐
pendent units (DIUs)

• PrimaryDisplayHeight: Height of the screen in device-in‐
dependent units (DIUs) 

• PrimaryDisplayPixelRatio: Ratio of the number of pixels to 
DIUs 
Example 1.5: 1000 DIU = 1500 pixels

Example of use
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let displayWidth = UI.GetClientInfo(UI.Enums.HmiClientInfoType.PrimaryDisplayWidth);
let displayHeight = UI.GetClientInfo(UI.Enums.HmiClientInfoType.PrimaryDisplayHeight);
if (displayHeight > displayWidth)
{
  UI.RootWindow.Screen = "StartScreenPortrait";  
}
else
{
  UI.RootWindow.Screen = "StartScreenLandscape";  
}

Tag values in report names
Introduction
In the "Reports" control you configure, among other things, the report name of the reports 
generated by a report job. The name consists of a combination of the following placeholders: 
• Placeholders with user-defined fixed texts 
• Placeholders that are dynamically evaluated during the generation.

The following dynamic placeholder types are available:
– Counter operations 
– Date
– V17 Update 1 or higher: Process value of an online tag 

As of V17 Update 1, new operator controls support you in configuring the report name.

Requirements
• Installed software: WinCC Unified Engineering V17 Update 1 and WinCC Unified Runtime 

V17 Update 1
• The "Reports" control contains a screen of the runtime project that is running.
• To use the new operator controls to configure the placeholders in the control, reload the 

project in runtime after installing the update (load changes).

Procedure
To integrate a tag value in the report name, follow these steps:
1. In the "Reports" control, select "Report jobs" tab.
2. Select a report job in the work area.

You can see the settings for the report job in the detail area.
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3. Next to "Report name", click "Configure".
You see the following operator controls:

① To select the placeholder type
② To add the new placeholder
③ Table for the exact configuration of the added placeholders or for removing a placeholder 

Note
For the default report name "Report_<Counter>", "Report name" has the 
value Report_{NNN}. The table shows two placeholders:
• Report_: Fixed text
• NNN: Dynamic placeholder for a counter

Note
Change order
To change the order of the placeholders, delete the existing placeholders and add them again 
in the desired order.
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4. Select the "Tag" value under "Select placeholder type".
An empty tag placeholder is added at the end of the table.

5. Select online tag:
– Click the "..." button on the placeholder
– In the "Tag selection" dialog, click "Fetch".

You can see all the tags of the runtime project that is running:

Note
Scrolling and filtering
Use the page navigation buttons to scroll forward or backward.
To filter the displayed tags, enter a filter string in "Filter" and click "Fetch".
You use the wildcard "*" to filter by partial strings.
For example:
• *T* returns all tags with a "T" in their name.
• *T returns all tags that end in "T".
• T* returns all tags that start with "T".
When filtering for structures, the separators must be part of the filter string.

– Click the desired tag.
– Confirm with "OK".
Alternatively, enter the full tag name manually in "Value". 
For example: Brewery_PC1_RT1::MyTag1

 In the "Report name" field, the tag placeholder is added to the end of the report name. 

Result
• When generating the report in runtime, the process value of the tag is read out and 

integrated into the report name.
• If the process value contains a character that is not permitted in file names, it is replaced by 

an underscore.
• If there is an error resolving the name, for example, because the tag is not found in runtime, 

the tag placeholder in the name is replaced by the error name. The process is logged in the 
generation status of the report.
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Alternative procedure
Enter the desired combination of fixed texts and dynamic placeholders manually in "Report 
name". 
To integrate a process value, use the following placeholder: {@<Full_TagName>}
Example: Report_{yyyymmdd}_{HHMMss}_{@Brewery_PC1_RT1::MyTag1}

Restrictions
• A report name can contain only one counter.
• Make sure that the generated report name does not violate the policy of the operating system 

regarding the maximum length of file names.

Operator control of text and graphic lists on a touch screen
If a text list or a graphic list is configured on a symbolic IO field, you can scroll through the entries 
in the list with touch gestures on a touch screen in runtime.
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4.6 Unified Runtime

4.6.1 Important notes
This page contains important information about product properties.

Simulation of external tags in tag simulator
External tags can only be simulated with the WinCC Unified Tag Simulator if the project running 
in runtime is connected to the corresponding controller.

WARNING
Effect on connected controllers
Note that the simulated process values are written to the automation system. This can cause a 
reaction of the connected process I/O.

Loading the logon page
If you experience display problems in the Web client after you install the update, completely 
delete the browser data (history, form entries, etc.).  

Alarm view
An alarm cannot be displayed as multiple line text in the alarm view.

Using a Web server certificate created with the Certificate Manager
If you use a Web server certificate created with Certificate Manager on the Runtime server, re-
install the certificate after you install the update.

Using the Excel add-in after changing the computer name
If you change the computer name of a computer after the Excel add-in has been installed, you 
must run WinCC Unified Configuration and integrate the manifest again as web add-in in Excel.

4.6.2 Improvements in Update 4
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.
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Text in the license box of the Asia dongle
The text of the alarm that indicates a missing dongle for an Asian language has been improved.

Screen keyboard
The behavior of the screen keyboard has been improved.

Shadowy objects
The shadowy objects that occur in conjunction with the "Show connection quality" property 
have been corrected.

Zooming in/out of screens
Zooming a screen with a touch gesture does not affect an open popup window.

Screens and screen objects
Bar
• The appearance of the bar has been improved in connection with the change of styles used 

in the "Runtime settings".
Screen window:
• The "Visibility" property of the graphic display is evaluated correctly even if the graphic 

display is used in a screen window.
• The display of the corners of a rectangle has been improved.
Browser
• The display of the Browser screen object has been improved so that even a deactivated 

function bar is displayed correctly.
• The "Browser" screen object shows the correct PDF page in runtime.
I/O field:
• The evaluation of the configured output formats has been improved for the I/O field.
• For the I/O field, the configured values for the "Spacing" property are displayed correctly in 

runtime, even if the object was originally created with WinCC V16. 
• The "Date and time" output format is displayed correctly.
Trend control
• The trend control displays the legend correctly even after changing the data source of a trend 

in runtime. 
• The data source of a trend control can be changed even after a comment on an alarm has 

been added to an alarm view.
• If the visibility of a trend area is dynamized with a tag, the trend is displayed correctly in the 

trend control after switching from "False" to "True".

Improvements in WinCC Unified
4.6 Unified Runtime

Readme
Readme, 06/2022, A5E51908378-AD 45



Alarm view:
• In the alarm view, the texts in the dialogs, such as the ones for filtering or sorting, are always 

displayed in the current runtime language.
• Scrolling in the alarm list has been improved.
Parameter set control
• The text in the information bar can be linked to a tag via the "Text" property and can be 

processed in a JScript, for example.
Slider:
• The slider displays the process value indicator - mode correctly.
Symbolic I/O field
• The display of the symbolic I/O has been improved regarding the use of transparent 

backgrounds.
• The display of graphics in the symbolic I/O field has been improved. 
Process control
• The "Delete archive value" button can be operated in runtime.
Text box
• If the "No." characters are configured in a text box, these characters are output correctly in 

runtime.
• When using the dark style, the text box is grayed out when the operator authorization is 

disabled.
• The display of centered text has been improved.

Faceplates
Text lists in faceplates are displayed correctly.
Graphics in I/O symbolic fields are displayed correctly.
A faceplate that is open as a popup is displayed in the specified position, even if the size of the 
faceplate container has been automatically adjusted to the screen size in the meantime.
If a faceplate has been opened in a popup and scripts are being executed, all scripts are stopped 
when you close the popup.
The display of transparent areas in a popup window has been improved.
When using the "WriteWithOperatorMessage" method in a faceplate, the tag name is displayed 
correctly in the alarm view.

Alarms and alarm view
In system alarms, the display of referenced parameters has been improved.
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Scripting
If the "Border - Color" property for an I/O field is changed via JScript, transparency is also displayed 
correctly.
If a pop-up window is opened dynamically in runtime and the "parentScreenPath" parameter is 
set, switching the display language is also possible at this time.
The Javascript instruction constructor.name is supported when the debugger for screen objects 
is disabled. This allows you to query the type of a screen object, for example:
let hmiType = Screen.Items('Circle_1').constructor.name // Result: 
HmiCircle
Even if an HMI device has been configured in a folder, the configured screens can be accessed via 
system functions, for example, when using the "ChangeScreen" system function.
Calling the GetPropertyValue system function returns the correct values for buttons in the 
toolbar of a configured parameter set control.
Debugging scripts is again possible without restriction.

"OpenFaceplateInPopup" function for Unified Comfort Panels
If a popup is called on a Unified Comfort Panel within a faceplate, it is displayed independently 
of the faceplate.

Reports 
When generating reports in runtime mode "Simulation", tags with Date and Time data type are 
output correctly in the report.
Error in the generation of PDF reports with newer MS Excel versions has been fixed.
The elements of structure tags are now output in reports sorted by the index number of the 
elements.
Data source items for PLC tags that have the "Cyclic in operation" acquisition mode now read the 
tag value directly from the PLC.
The installation of the Excel add-in on computers whose Excel uses the CH-ZN type language 
pack is now successful.

Certificate Manager
Removing devices from the Certificate Manager works correctly even if devices were logged on 
with only the IP address.
You can now renew the entire certificate configuration in the Certificate Manager. The certificate 
configuration also includes the application certificates of the devices.
To do this, select "Recreate all" in the shortcut menu on the root certificate.

VoT: Display of website
The display of the website could no longer be displayed under certain circumstances with V17 
Update 2. The cause of this error has been fixed.
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The indirect addressing of the tags works correctly.

Custom web controls
Custom web controls that were no longer displayed with V17 Update 2 can be used again.
If a start value and a tag are assigned to an I/O field, the custom web control applies the value 
of the assigned tags after updating the screen.

4.6.3 Improvements in Update 3

Contents
This update does not contain any improvements or changes relevant to WinCC Unified Runtime.

4.6.4 Improvements in Update 2
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

4.6.5 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Changing the computer name or the IP address 
If the computer name or the IP address of a WinCC Unified HMI device changes, e.g. when adding 
the computer to a domain, follow these steps:
1. After changing the computer name or IP address on the HMI device, run WinCC Unified 

Configuration.
WinCC Unified Configuration automatically adjusts the computer name or IP address.

2. On the computer that serves as the certification authority, use WinCC Unified Certificate 
Manager to renew the certificate configuration of the HMI device.
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3. If the HMI device participates in Unified Collaboration, adapt the configuration of the other 
devices in engineering system and download the changes to the devices.

4. If you use central user management and change the computer name of a Unified PC, you have 
to enter the new computer name on the UMC-S ring server manually in the whitelist. 
You can find additional information in the SIOS Portal, in the application example with the ID 
109780337.

The projects loaded onto the HMI device using a user configuration loaded by TIA Portal are 
subsequently executable without reloading. 

Note
Adapt the configuration of the HMI device in engineering system before reloading the HMI 
device.

Adapting the runtime configuration

Note
If the computer name is used to access the website for the web clients, no adaptation of the 
runtime configuration in WinCC Unified Configuration is necessary after changing the IP address, 
and vice versa.

1. Start WinCC Unified Configuration.
2. To only include changes to the computer name or the IP address in the configuration, follow 

these steps:
– In the "Website settings" step, select the option "Only adapt to new computer name or IP 

address".
– Click "Next".
– In the "Apply Settings" step, click "Accept".

3. To change other settings, follow these steps:
– In the "Website settings" step, select the "Perform additional configuration" option.
– Click "Next" and make the required settings in the following steps.
– In the "Apply settings" step, click "Accept".

Adapting device certificates
1. Start WinCC Unified Certificate Manager on the computer that serves as the certification 

authority.
2. Delete the HMI device whose host name or IP address has been changed from the Certificate 

Manager.
3. Add the HMI device again and enter the new computer name or the new IP address.
4. Generate the required certificates for the device.
5. Distribute and install the certificates.
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Note
If the computer name or IP address of the certification authority has changed, you have to 
recreate, distribute and install the root certificate and the certificates of all Unified devices.

Automatic login for local Web clients
A local Web client is a Web client located on the same HMI device as WinCC Unified Runtime. 
Automatic login can be enabled for the local Web client of a Unified PC. 
Follow the steps below:
1. On the Unified PC, open the SIMATIC Runtime Manager as administrator.
2. Click the button  in the toolbar.
3. Select the "General" tab.
4. Under "Automatic login", enable the "Activate automatic login" option.
5. Enter the user name and password of the UMC user that is to use automatic login if no UMC 

user is logged in in runtime via UMC Desktop Single Sign-on yet when the local Web client is 
started or on login to runtime.

6. Confirm your entries with "OK".
7. Restart runtime.  
Result:
• On the start of a local Web client or on connection to runtime, the Web client automatically 

authenticates itself with the following user data: 

A UMC user is already logged in on the HMI device via UMC Desktop Single Sign-on (DSSO)
Yes The logged-in user is used.
No The user configured in SIMATIC Runtime Manager is used.

If no user has been configured in SIMATIC Runtime Manager, a hard-coded de‐
fault user without function rights is used.

All local Web clients use the same logged-in user. 
• Operators see the start screen of the project running in runtime. 
• If the logged-in user does not have the authorization to operate a screen element, a login 

dialog opens. 
To operate the screen element, the operator must log in with a user with corresponding 
function rights. The open process screens remain open. 

• After logout of the user used for automatic login, e.g. via the "LogOff" system function, or 
after switchover to another user, automatic login is only possible again after runtime is 
restarted.
Logout takes effect in all applications that use DSSO. The local Web client switches to the 
hard-coded default user without function rights. The open process screens remain open. 
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4.6.6 Improvements in the option update
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.
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4.7 Unified Panels

4.7.1 Important Information (Unified Comfort Panels)
Information that could not be included in the documentation and important information about 
product characteristics.

Configuring connections
For the Unified Comfort Panel in the engineering system, only configure control connections 
that are also available and used in plant operation.

Runtime and web client
Functional differences
Due to different technologies, temporary functional differences may occur between the 
operation of a Unified Comfort Panel runtime and a web client.
For example, not all buttons can be operated when operating the trend control directly on the 
Panel runtime. The web client has the same behavior as the Unified PC runtime. For this reason, 
the "Print" button, for example, can also be operated in the trend control.
Option to change user
If you use runtime locally on the Unified Comfort Panel, you will be shown an option to switch 
the user if you do not have sufficient function rights. This option does not apply to access via a 
web client. The following applies here depending on the HMI device image version used:
• HMI device image versions V17.0.0.0 and V17.0.0.1: A note about insufficient authorizations 

is displayed in the web client.
• HMI device image version 17.0.0.2 or higher: Operating objects without access 

authorization are shown grayed out.
To receive access to these operating objects, the user needs to log off and log on again as another 
user with the necessary access authorization.

Generic logon error due to browser language settings
If a language that is not supported by Unified Runtime is set as the browser language, the 
"Generic error" occurs during logon.
Proceed as follows:
1. Open the browser language settings.
2. Select one of the languages supported by Unified Runtime.
3. Log on in runtime.

Browser download directory
On a Unified Comfort Panel, the browser download directory is: "/home/industrial/download"
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Using the central user management
The following sections contain important information on parameters of the "TIA User 
Management Component (UMC)".
Auto logoff time
The UMC parameter "Account Policy > Auto logoff time (minutes)" is not supported by Unified 
Comfort Panels. A user logged on to the Unified Comfort Panel must log off manually.
Must change Password
The UMC parameter "Status > Must change Password" is not supported by Unified Comfort 
Panels. Make sure that this option is disabled for all users of a Unified Comfort Panel.
Password duration (days)
An expired password cannot be changed on a Unified Comfort Panel. To log on a user whose 
password has expired, change the password directly in the "TIA User Management Component".

Unified Collaboration
Note the following information when accessing a Unified PC from a Unified Comfort Panel via 
Unified Collaboration:
• Alarms on the Unified PC might be displayed on the Unified Comfort Panel with a delay.
• In the configuration of the Unified Comfort Panel, the Unified PC must be selected in the list 

"Connect actively to" under "Runtime settings > Remote Access > Collaboration".
In the configuration of the Unified PC, the Unified Comfort Panel must be selected in the list 
"Connect actively to" under "Runtime settings > Collaboration". 
Note: If the Unified Collaboration devices belong to different TIA projects, a bidirectional 
export/import of the screen references for Unified Collaboration is required to be able to 
execute the above operations.

Note the following information when accessing a Unified Comfort Panel from a Unified PC via 
Unified Collaboration:
• To access the screens of the Unified Comfort Panel, execute a screen change on the Unified 

PC after the first project download.
Note the following information when accessing another Unified Comfort Panel from a Unified 
Comfort Panel via Unified Collaboration:
• In the configuration of both Unified Comfort Panels, Unified Collaboration must be selected 

in the list "Connect actively to" under "Runtime settings > Remote Access > Collaboration".
Note: If the Unified Collaboration devices belong to different TIA projects, a bidirectional 
export/import of the screen references for Unified Collaboration is required to be able to 
execute the above operation.

Password guidelines for SmartServer
The passwords of "User 1" and "User 2" for accessing the SmartServer must be different, consist 
of exactly 8 characters and contain the following characters:
• At least one uppercase letter (A ‑ Z)
• At least one lowercase letter (a ‑ z)

Improvements in WinCC Unified
4.7 Unified Panels

Readme
Readme, 06/2022, A5E51908378-AD 53



• At least one number (0 - 9)
• At least one special character (! $ % & ( ) * + , - . / : ; < = > ? @ [ \ ] _ { | } ~ ^) 

Display of I/O fields
As of HMI device image version 17.0.0.2, the following applies for I/O fields: It is not possible to 
enter a value outside the configured value range.
An I/O field is displayed with a red background for approx. two seconds depending on the data 
type of the assigned tag in the following cases:
• Integer and real tags: The entered value is outside the configured value range.
• String tag: The entered value exceeds the configured length of the string.
After entering a value outside the configured value range, the I/O field displays the last valid 
value.

Alarm view
Sorting
The configurable standard sorting direction is not evaluated in alarm view.
To sort column contents in Unified Runtime, use column sorting or the "Sorting setup" button on 
the toolbar.

Flashing on range violation
Flashing on range violation is not supported for the alarm view.

Scroll bars
Scroll bars are not available in the alarm view. Use the touchscreen to move the contents of the 
alarm view horizontally or vertically.

"Show recent" button
The "Show recent" function is only supported in conjunction with ascending sort order.

Moving columns
Moving columns within the alarm view is not supported.

Status bar
If a text was configured for the first element in the status line and an image for the second 
element, the image may not be displayed immediately after loading. In this case, perform a 
screen change.

Filter alarms
Multiple selection of filter criteria is not supported in the filter dialog of the alarm view.

Dynamize visibility of columns
The dynamization of the visibility of columns via a script or a system function is not supported.
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"LogOff" system function
An operating object with the "LogOff" system function must not be access-protected via the 
"Authorization" function. Use two separate operating objects for the "LogOn" and "LogOff" 
functions.

4.7.2 Improvements in V17 Upd. 2 (Unified Comfort Panels)
This update contains the HMI device image version 17.0.0.2. To make use of the corresponding 
engineering and runtime improvements, we recommend using WinCC Unified V17 Update 2 for 
configuring the HMI devices.

User administration
Number of logon attempts
The number of attempts to correctly input the logon credentials has been increased to 19. If the 
logon credentials are entered incorrectly again, the user involved is locked out. The user must be 
deleted and recreated, or you must reload the User Management into the HMI device.
System tag "@UserName"
The behavior of the system tag "@UserName" has been improved in HMI device image V17.0.0.2 
as compared to HMI device image V17.0.0.1. When a user logs off, the system tag "@UserName" 
is reset correctly again.

SIMATIC Edge
As of HMI device image version 17.0.0.2, Unified Comfort Panels can use the "Standalone" or 
"Backend Managed" Industrial Edge management.
When "Apps" > "SIMATIC Edge" > "Open edge management" is clicked on for the first time, the 
"Activate Edge Device" dialog with the two possible options is displayed.
You can find detailed information in the Operating Manual "SIMATIC HMI Unified Comfort Panels 
Industrial Edge Device - Operation (https://support.industry.siemens.com/cs/ww/en/view/
109804671)".

Note
Select a user name without uppercase letters
The "SIMATIC Edge" login is only possible for user names without capital letters.

Trace logger
In the Control Panel, the new option "Enable Trace logger" is available under "Service and 
Commissioning" > "Trace forwarder". With this option, you can save "tracing" information on an 
external storage medium. Additional information can be found on the Internet (https://
www.siemens.com/ucp-cp-v17-help).
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Supported printers
The following "Brother" printers were added on the local website "CUPS":
• BrGenML1
• HL4150CDN
• HLL2360D
• HLL5100DN
• HLL5200DW
• QL650 TD
• QL700
Open the local website "CUPS" via "Apps" > "Printer configuration" > "Printers".

Web Browser app
As of HMI device image version 17.0.0.2, the pre-installed app "Web Browser" is based on Firefox.
Some pages that use self-signed certificates may need to be classified as trusted in the 
certificate management of the web browser to avoid error messages.
Use the start script "runFirefox.sh" to start the "Web Browser" app from the project. 

Control Panel help
In the title bar, you will find the "Help" button to the left of the "Login" button.

Use the "Help" button to open the "Unified Comfort Panels Help" dialog.
In the "Unified Comfort Panels Help" dialog, you have the following options to open the Control 
Panel help:
• Scan the QR code or enter the link under the QR code in the browser of an external device with 

Internet connection.
The help will be opened on the external device. You can read the help on the external device 
and navigate in the Control Panel of the HMI device at the same time.

• If your HMI device has an Internet connection, click the link under the QR code.
The help will open on the HMI device.

4.7.3 Improvements in V17 Upd. 1 (Unified Comfort Panels)
This update contains the HMI device image version 17.0.0.1 for projects that were configured 
with WinCC Unified V17 Update 1.
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Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Audit for Unified Comfort Panel
Unified Comfort Panels support the Audit option as of Update 1.
When creating the project, make sure that verifiable operator actions can only be performed by 
authorized personnel, e.g. by configuring buttons with an "Allow operator control" operator 
authorization. If a user can perform a verifiable operating action without first logging on to the 
device, this may result in an insufficient verification requirement.

Trend control
You can also use a trend control to configure the "Min Max" compression mode for Unified 
Comfort Panel.
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Improvements in TIA Portal Openness 5
This update contains the following improvements and changes:

Update 4 - Importing logging tags
The creation of logging tags with cyclic trigger with TIA Portal Openness has been improved. 

Update 1 - Access to structured tags
As of V17 Update1, TIA Portal Openness supports access to structured tags via the Openness API.

 
private static void ReadWriteStructuredTagDynamization(HmiScreenItemBase hmiScreenItemBase)
{
var tagDynamization = hmiScreenItemBase.Dynamizations[0] as TagDynamization;
// Read structured tag
Console.WriteLine("Name: " + hmiScreenItemBase.Name + " Tag: " + tagDynamization.Tag);
// Write structured tag
tagDynamization.Tag = "HMITag_1.MainTag.Tag1.Element2";
}
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